
   

  1 
 

 

 

Help Manual 
for 

Facilitators 
(Writer 2) 

 

 

Computer Shiksha 
 

 

G-576, Florence Homes, Sushant Lok II, Sector 57, Gurgaon 122011, Haryana 

Contact for Support: 9910623004 (whatsapp) 

E-mail id: connect@computershiksha.org 

Skype: computer.shiksha 
Contact for Admin Info: 0124-4112926 

Version no 15-5-2017 

 
 

mailto:connect@computershiksha.org


   

  2 
 

Table of contents for Writer 2       

                                                                                    Page no 

Class 1                                                   3 to 12  

Class 2                                                 13 to 23 

Class 3                                                 24 to 33 

Class 4                                                 34 to 41 

Class 5                                                 42 to 56 

Class 6                                                 57 to 66 

      Class 7                                                   67 to 76 

      Class 8                                                   77 to 86 

      Class 9                                                   87 to 99 

      Class 10                                                100 to 106 

      Class 11                                                107 to 117 

 

 



   

  3 
 

 

 

 

 

Complete teacher’s manual for Open office writer 2 Class 1 

Summaries 

 

 How to open writer file? 

 What is the use of tool bar 

 What is difference between page layout and web layout? 

 Why use we status bar? 

 What is text boundaries? 

  How to show and hide formatting  bar? 

 What is ruler? 

 What is non-printing characters? 

 How to zoom in and zoom out on the page 

 How to shut down computer. 

Now let’s start video. 

 

1. To stop video time at 48seconds in VLC Media Player. 

 

Stop video here and ask them if they remember what they learnt in writer 1? 

Just listen to the answers and play the video again for the correct answer. 
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2. To stop video time at 1 minute 17 seconds in VLC Media Player. 

 

Stop video here and ask if they know why ‘Formatting toolbar’ is used? 

Just listen to the answers and play the video again for the correct answer. 

 

3. To stop video time at 1 minute 46 seconds in VLC Media Player. 

 

Stop video here and ask what is ‘export as PDF’? And what is the full form of 

‘PDF’? 

Just listen to the answers and play the video again for the correct answer. 

 

4. To stop video time at 2 minute 22 seconds in VLC Media Player. 
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Stop video here and ask why we use ‘Find and Replace’? 

Just listen to the answers and play the video again for the correct answer. 

 

5. To stop video time at 2 minute 41 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file as shown in the video and 

then play the video again. 

 

6. To stop video time at 3 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to press Window + R button as explained in 

video.  
Just check if they have pressed window + R button or not and then play the 

video again. 

 

7. To stop video time at 3 minute 55 seconds in VLC Media Player. 

Stop video here and ask students to type ‘swriter’ in the run command box as 

shown in video.  
Just check if they have typed or not and then play the video again. 

 

8. To stop video time at 4 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to Click on ‘OK’ button as shown in video.  



   

  6 
 

Now Just check if they have opened writer file or not and then play the video 

again. 

 

 

 

 

 

9. To stop video time at 4 minute 45 seconds in VLC Media Player. 

 

Stop video here and ask what will we learn today? 

Just listen to the answers and play the video again for the correct answer. 

 

10. To stop video time at 4 minute 54 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given paragraph as shown in the 

video and then play the video again. 

 

11. To stop video time at 5 minute 07 seconds in VLC Media Player. 
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Stop video here and ask if they know the differences between ‘Print layout’ and 

‘Web layout’ 

Just listen to the answers and play the video again for the correct answer. 

 

12. To stop video time at 05 minute 50 seconds in VLC Media Player. 

Stop video and ask students to do for Print layout and Web layout as shown in 

the video and then play the video again.  

 

13. To stop video time at 6 minute 14 seconds in VLC Media Player. 

Stop video and ask students to do writer page in ‘Web layout’ format as shown 

in the video and then play the video again. 

 

14. To stop video time at 6 minute 31 seconds in VLC Media Player. 

Stop video and ask students to do in ‘Print layout’ format as shown in the video. 

Now just check whether they’ve changed the layout of the page or not and then 

play the video again. 

 

15. To stop video time at 6 minute 39 seconds in VLC Media Player. 

 
Stop video and ask if they can tell why the ‘Toolbar’ is used? 
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Just listen to the answers and play the video again for the correct answer. 

 

16. To stop video time at 7 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to click on the View menu as shown in video 

and then play the video again. 

 

 

 

17. To stop video time at 7 minute 45 seconds in VLC Media Player. 

Stop video and ask students to hide ‘Drawing Toolbar’ as shown in the video 

and then play the video again. 

 

18. To stop video time at 8 minute 10 seconds in VLC Media Player. 

Stop video and ask students to Hide ‘Formatting bar’ as shown in the video and 

then play the video again. 

 

19. To stop video time at 8 minute 24 seconds in VLC Media Player. 

Stop video and ask students to hide ‘Standard toolbar’ as shown in the video 

and then play the video again. 

 

20. To stop video time at 8 minute 45 seconds in VLC Media Player. 

Stop video and ask students to bring back the ‘Drawing toolbar’ as shown in the 

video and then play the video again. 

 

21. To stop video time at 8 minute 56 seconds in VLC Media Player. 

Stop video and ask students to bring back the ‘Formatting toolbar’ as shown in 

the video and then play the video again. 

 

22. To stop video time at 9 minute 26 seconds in VLC Media Player. 

Stop video and ask students to show ‘Standard toolbar’ as shown in the video 

and then play the video again. 

 

23. To stop video time at 9 minute 35 seconds in VLC Media Player. 
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Stop video here and ask why we use ‘Status bar’? 

Just listen to the answers and play the video again for the correct answer. 

 

24. To stop video time at 09 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to click on the View menu as shown in the 

video and then play the video again. 

 

25. To stop video time at 10 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to hide ‘Status bar’ as shown in video and then 

play the video again. 

 

26. To stop video time at 11 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to show the Status bar as shown in video. 

Now just check whether the ‘Status bar’ is showing again or not and then play 

the video again. 

 

27. To stop video time at 11 minute 45 seconds in VLC Media Player. 

 

Stop video here and ask if they know what is ‘Ruler’ and how many types of 

‘Rulers are there? 
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Just listen to the answers and play the video again for the correct answer. 

 

28. To stop video time at 12 minute 20 seconds in VLC Media Player. 

Stop video here and ask the students to hide the ‘Ruler’ option as shown in the 

video and then play the video again. 

 

29. To stop video time at 12 minute 40 seconds in VLC Media Player. 

Stop video here and ask the students to show the ‘Ruler’ option as shown in the 

video. 

Now just check whether the ‘Ruler’ is shown or not and then play the video 

again. 

 

30. To stop video time at 12 minute 51 seconds in VLC Media Player. 

 

 

Stop video here and ask if they can tell what is‘Text Boundaries’? 

Just listen to the answers and play the video again for the correct answer. 

 

31. To stop video time at 13 minute 51 seconds in VLC Media Player. 

Stop video here and ask the students to hide the ‘Text Boundaries’ option as 

shown in the video and then play the video again. 

 

32. To stop video time at 14 minute 12 seconds in VLC Media Player. 

Stop video here and ask the students to bring back ‘Text Boundaries’ option as 

shown in the video and then play the video again. 

 

33. To stop video time at 15 minute 30 seconds in VLC Media Player. 
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Stop video here and ask the students to show the ‘Non-printing Characters’ 

option as shown in the video and then play the video again. 

 

34. To stop video time at 15 minute 48 seconds in VLC Media Player. 

Stop video here and ask the students to hide the ‘Non-printing Characters’ as 

shown in the video. 

Now just check whether the ‘Non –printing characters is hidden or not and then 

play the video again. 

  

 

35. To stop video time at 16 minute 16 seconds in VLC Media Player. 

 

Stop video here and ask How to do ‘Full screen’? 

Just listen to the answers and play the video again for the correct answer. 

 

36. To stop video time at 16 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to do the Full screen of the page as shown in 

the video. 

Just check and play the video again. 

 

37. To stop video time at 17 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to do the Normal page as shown in the video 

and then play the video again. 

 

38. To stop video time at 18 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to practice the ‘Zoom’ option as shown in 

video and then play the video again.   
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39. To stop video time at 18 minute 45 seconds in VLC Media Player. 

 

Stop video here and ask students to close the writer page and then play the 

video again? 

 

40. To stop video time at 19 minute 36 seconds in VLC Media Player. 

 
Stop video here and ask how to shutdown a computer. 

Just listen to the answers and play the video again for the correct answer. 
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Complete teacher’s manual for Open office writer 2 Class 2 

Summaries 

 

 How to open writer file? 

 What is the use of tool bar 

 What is difference between page layout and web layout? 

 Why use we status bar? 

 What is text boundaries? 

  How to show and hide formatting  bar? 

 What is ruler? 

 What is non-printing characters? 

 How to zoom in and zoom out the page 

 How to shut down computer. 

Now let’s start video. 

 

 

41. To stop video time at 16 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use ‘View’ menu? 

Just listen to the answers and play the video again for the correct answer. 
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42. To stop video time at 37 seconds in VLC Media Player. 

 

Stop video here and ask if they know the difference between ‘Page layout and 

Web layout’? 

Just listen to the answers and play the video again for the correct answer. 

 

43. To stop video time at 1 minute 04 seconds in VLC Media Player. 

 

Stop video here and ask if they know how to remove ‘Drawing tool bar’? 

Just listen to the answers and play the video again for the correct answer. 

 

44. To stop video time at 1 minute 30 seconds in VLC Media Player. 

 

Stop video here and ask why we use ‘Find and Replace’? 
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Just listen to the answers and play the video again for the correct answer. 

 

45. To stop video time at 1 minute 54 seconds in VLC Media Player. 

 
Stop video here and ask students to open the writer file and then play the video 

again. 

 

46. To stop video time at 2 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to press Window + R button as shown in 

video.  
Just check if the run command box is opened or not and then play the video 

again. 

 

47. To stop video time at 3 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to type ‘Swriter’ as shown in video.  
Just check if they have typed or not and then play the video again. 

 

48. To stop video time at 3 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to Click on ‘OK’ button as shown in video.  
Just check whether their file is opened or not then play the video again. 

 

 

 

 

 

 

 

49. To stop video time at 3 minute 56 seconds in VLC Media Player. 
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Stop video here and ask what will we learn today? 

Just listen to the answers and play the video again for the correct answer. 

 

50. To stop video time at 4 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask students to type the given line which is shown in video 

and also ask to do copy and paste of this line 10 times and then play the video 

again.  

 

51. To stop video time at 6 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to do copy and paste of the given line as 

shown in the video. 

Now just check if everyone has done so and play the video again. 

 

52. To stop video time at 7 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to do copy and paste 10 times as shown in the 

video. 

Now just check whether they’ve copied 10 times or not and then play the video 

again. 
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53. To stop video time at 7 minute 40 seconds in VLC Media Player. 

 

Stop video here and ask students to hide ‘Formatting bar’ and then play the 

video again. 

 

54. To stop video time at 8 minute 33 seconds in VLC Media Player. 

Stop video here and ask them to hide the ‘Formatting Toolbar’ as shown in the 

video. 

Now just check whether they have hidden the ‘Formatting toolbar’ or not and 

then play the video again. 

 

55. To stop video time at 8 minute 47 seconds in VLC Media Player. 

 

Stop video here and ask students to hide the ‘Text Boundaries’ and then play the 

video again. 

 

 

 

56. To stop video time at 9 minute 37 seconds in VLC Media Player. 

Stop video here and ask them to hide the ‘Text Boundaries’ as shown in the 

video. 
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Now just check and whether they have hidden the ‘Text boundaries’ or not and 

then play the video again. 

 

57. To stop video time at 9 minute 43 seconds in VLC Media Player. 

 

Stop video here and ask students to hide the ‘Drawing Toolbar’ and then play 

the video again 

. 

58. To stop video time at 10 minute 28 seconds in VLC Media Player. 

Stop video here and ask them to hide the ‘Drawing Toolbar’ as shown in the 

video. 

Now just check whether they have removed the Drawing toolbar’ or not and 

then play the video again. 

 

59. To stop video time at 10 minute 35 seconds in VLC Media Player. 

 

Stop video here and ask students to show the ‘Non-printing Characters’ and 

then play the video again. 

 

60. To stop video time at 11 minute 28 seconds in VLC Media Player. 
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Stop video here and ask them to show the Non-printing Characters as shown in 

the video. 

Now just check if everyone has done so and play the video again. 

 

61. To stop video time at 11 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to hide the ‘Standard Toolbar’ and then play 

the video again. 

 

62. To stop video time at 12 minute 02 seconds in VLC Media Player. 

Stop video here and ask them to hide ‘Standard toolbar’ as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

63. To stop video time at 12 minute 10 seconds in VLC Media Player. 

 
Stop video here and ask the students to zoom out the page and then play the 

video again. 

 

 

64. To stop video time at 12 minute 56 seconds in VLC Media Player. 
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Stop video here and ask the students to zoom out the page as shown in the 

video. 

Now just check if everyone has done so and play the video again. 

 

65. To stop video time at 11 minute 02 seconds in VLC Media Player. 

 

Stop video here and ask students to bring back ‘Formatting Bar’ and then play 

the video again. 

 

66. To stop video time at 13 minute 44 seconds in VLC Media Player. 

Stop video here and ask them to show the ‘Formatting Toolbar’ as shown in the 

video. 

Now just check if everyone has done so and play the video again. 

  

67. To stop video time at 13 minute 47 seconds in VLC Media Player. 

 

Stop video here and ask students to bring back the ‘Drawing Bar’ and then play 

the video again. 

 

 

68. To stop video time at 14 minute 17 seconds in VLC Media Player. 
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Stop video here and ask them to show the ‘Drawing Toolbar’ as shown in the 

video. 

Now just check if everyone has done so and play the video again. 

 

69. To stop video time at 14 minute 23 seconds in VLC Media Player. 

 

Stop video here and ask students to remove the ‘Non-printing Characters ‘and 

then play the video again. 

 

70. To stop video time at 14 minute 55 seconds in VLC Media Player. 

Stop video here and ask them to hide the ‘Non-printing Characters’ as shown in 

the video. 

Now just check if everyone has done so and play the video again. 

 

71. To stop video time at 15 minute 00 seconds in VLC Media Player. 

 

Stop video here and ask them to show the ‘Text Boundaries’ and then play the 

video again. 

 

72. To stop video time at 15 minute 26 seconds in VLC Media Player. 
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Stop video here and ask them to show the ‘Text Boundaries’ as shown in the 

video. 

Now just check if everyone has done so and play the video again. 

 

73. To stop video time at 15 minute 30 seconds in VLC Media Player. 

 

Stop video here and ask students to bring back the ‘Standard Toolbar’ and then 

play the video again. 

 

74. To stop video time at 16 minute 18 seconds in VLC Media Player. 

Stop video here and ask them to show ‘Standard Toolbar’ as shown in the video 

and. 

Now just check if everyone has done so and play the video again. 

 

75. To stop video time at 16 minute 24 seconds in VLC Media Player. 

 
Stop video here and ask them to zoom in the page to 100% and then play the 

video again. 

 

 

76. To stop video time at 17 minute 16 seconds in VLC Media Player. 



   

  23 
 

Stop video here and ask them to increase the page size as shown in the video 

and. 

Now just check if everyone has done so and play the video again. 

 

77. To stop video time at 17 minute 36 seconds in VLC Media Player. 

 

 

Stop video here and ask students to close their file and then play the video 

again. 

 

78. To stop video time at 18 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to shut down the computer properly and then 

play the video again. 
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Complete teacher’s manual for Open office writer 2 Class 3 

Summaries 

 

 How to open writer file? 

 Use of insert menu. 

 About the manual break. 

 What is header and footer? 

 What is the use of hyperlink? 

 How to insert hyperlink? 

 How to insert pictures on the writer page? 

 How to draw shapes on the writer page? 

 How to shut down computer. 

Now let’s start video. 

79. To stop video time at 22 seconds in VLC Media Player. 

 

Stop video here and ask students, if they can tell what are None-printing 

characters? 

Just listen to the answers and play the video again for the correct answer. 

 

80. To stop video time at 56 seconds in VLC Media Player. 
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Stop video here and ask the students, do they know the differences between 

‘Undo and Redo’? 

Just listen to the answers and play the video again for the correct answer. 

 

81. To stop video time at 1 minute 22 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell how will they remove ‘Status bar’? 

Just listen to the answers and play the video again for the correct answer. 

 

82. To stop video time at 1 minute 41 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Find and Replace’ option? 

Just listen to the answers and play the video again for the correct answer. 
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83. To stop video time at 2 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask students to open the writer file using any method and 

then play the video again. 

 

84. To stop video time at 3 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to open writer file as shown in the video. 

Now just check whether they have opened the writer file or not and then play 

the video again. 

 

85. To stop video time at 3 minute 46 seconds in VLC Media Player. 

 

Stop video here and ask, what will we learn today? 

Just listen to the answers and play the video again for the correct answer. 
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86. To stop video time at 3 minute 52 seconds in VLC Media Player. 

 

Stop video here and ask students to type the paragraph as shown in video? 

Now just check and play the video again.  

 

87. To stop video time at 4 minute 03 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why the Insert menu is used? 

Just listen to the answers and play the video again for the correct answer. 

 

88. To stop video time at 4 minute 30 seconds in VLC Media Player. 
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Stop video here and ask if they know what is ‘Manual Break’ option and why 

we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

89. To stop video time at 5 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Manual Break’ option as shown in 

the video and then play the video again. 

 

90. To stop video time at 6 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Page Break’ option as shown in 

the video and then play the video again. 

 

91. To stop video time at 6 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to do ‘Line Break’ as shown in the video and 

then play the video again. 

 

92. To stop video time at 7 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

Now just check, whether they’ve used ‘Manual Break’ option or not, and play 

the video again. 

 

93. To stop video time at 7 minute 17 seconds in VLC Media Player. 

 

Stop video here and ask why we use ‘Fields’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

94. To stop video time at 8 minute 50 seconds in VLC Media Player. 



   

  29 
 

Stop video and ask the students to insert the date as shown in the video and play 

the video again. 

 

95. To stop video time at 9 minute 56 seconds in VLC Media Player. 

Stop video and ask the students to insert the ‘Time’, ‘Page number’, ‘Page 

count’ as shown in the video and play the video again. 

Now just check, whether they’ve inserted the ‘Fields name’ or not, and play the 

video again. 

 

96. To stop video time at 10 minute 01 seconds in VLC Media Player. 

 

Stop video and ask if they know why we use ‘Hyperlink’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

97. To stop video time at 10 minute 56 seconds in VLC Media Player. 

Stop video and ask students to click on the Insert menu and then play the video 

again. 

 

98. To stop video time at 11 minute 10 seconds in VLC Media Player. 

Stop video and ask the students to click on the ‘Hyperlink’ option as shown in 

the video. 

Just check whether the box has appeared or not as shown in the video and then 

play the video again. 

 

 

 

99. To stop video time at 12 minute 12 seconds in VLC Media Player. 
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Stop video here and ask students to choose any file and then click the ‘open’ 

button as shown in the video. 

Just check and play the video again. 

 

100. To stop video time at 12 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘apply’ button and then 

followed by ‘close’ button as shown in the video. 

Just check and play the video again. 

 

101. To stop video time at 13 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to open the Hyperlink as shown in the video. 

Just check whether they have opened the link or not and then play the video 

again. 

 

102. To stop video time at 13 minute 16 seconds in VLC Media Player. 

Stop video here and ask the students to close the current page and then play the 

video again. 

 

103. To stop video time at 13 minute 22 seconds in VLC Media Player. 

 

Stop video here and ask them do they know what is ‘Header’ and how to use it? 

Just listen to the answers and play the video again for the correct answer. 

 

104. To stop video time at 14 minute 31 seconds in VLC Media Player. 

Stop video here and ask the students to insert the ‘Header’ as shown in the 

video. 

Just check whether they’ve inserted the header or not and play the video again. 
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105. To stop video time at 15 minute 20 seconds in VLC Media Player. 

Stop video here and ask the students to type story name in the ‘Header box’ as 

shown in the video and then play the video again. 

 

106. To stop video time at 15 minute 26 seconds in VLC Media Player. 

 

Stop video here and ask them do they know what is ‘Footer’ and why is it used? 

Just listen to the answers and play the video again for the correct answer. 

 

107. To stop video time at 16 minute 18 seconds in VLC Media Player. 

Stop video here and ask the students to insert the ‘Footer’ as shown in the video. 

Just check and play the video again. 

 

108. To stop video time at 17 minute 08 seconds in VLC Media Player. 

Stop video here and ask the students to insert the date and page number on the 

‘Footer box’ as shown in the video and then play the video again. 

 

109. To stop video time at 17 minute 14 seconds in VLC Media Player. 

Now just check whether students have inserted ‘Header and Footer’ or not and 

then play the video again. 

 

 

110. To stop video time at 17 minute 20 seconds in VLC Media Player. 
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Stop video here and ask them if they know how to bring pictures on the writer 

page. 

Just listen to the answers and play the video again for the correct answer. 

 

111. To stop video time at 17 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Insert’ menu and then click on 

the ‘Picture’ option as shown in the video and then play the video again. 

 

112. To stop video time at 18 minute 41 seconds in VLC Media Player. 

Stop video here and ask students to choose any picture and then click on the 

‘Open’ button as shown in the video and then play the video again. 

 

113. To stop video time at 18 minute 53 seconds in VLC Media Player. 

Stop video here and check whether they have inserted a picture or not and then 

play the video again. 

 

114. To stop video time at 19 minute 49 seconds in VLC Media Player. 

Stop video here and ask the students to draw the Oval from the Drawing bar as 

shown in the video. 

Now just check if everyone has done so and play the video again. 

 

115. To stop video time at 20 minute 34 seconds in VLC Media Player. 

Stop video here and ask the students to change the shape outline and line width 

from the drawing bar as shown in the video. 

Now just check if everyone has done so and play the video again.. 

 

116. To stop video time at 21 minute 04 seconds in VLC Media Player. 



   

  33 
 

Stop video here and ask the students to change the shape outline color and area 

color from the drawing bar as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

117.  To stop video time at 21 minute 26 seconds in VLC Media Player. 

 

Stop video here and ask the students to save the writer file and then shut down 

the computer. 

Just check whether they have shut down the computer or not. 
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Complete teacher’s manual for Open office writer 2 Class 4 

Summaries 

 

 How to open writer file? 

 Use of insert menu. 

 About the manual break. 

 What is header and footer? 

 What is the use OF hyperlink? 

 How to insert hyperlink? 

 How to insert pictures on the writer page? 

 How to draw shapes on the writer page? 

 How to shut down computer. 

Now let’s start video. 

 

118. To stop video time at 30 seconds in VLC Media Player. 

 

Stop video here and ask them if they know why we use ‘Page Break’? 

Just listen to the answers and play the video again for the correct answer. 

 

119. To stop video time at 48 seconds in VLC Media Player. 
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Stop video here and ask them if they know what is ‘Fields’ option ? 

Just listen to the answers and play the video again for the correct answer. 

 

120. To stop video time at 1 minute 07 seconds in VLC Media Player. 

\  

Stop video here and ask if they can tell what is ‘Hyperlink’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

121. To stop video time at 1 minute 30 seconds in VLC Media Player. 

 

Stop video here and ask what is ‘Header and Footer’ option ? 

Just listen to the answers and play the video again for the correct answer. 
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122. To stop video time at 2 minute 05 seconds in VLC Media Player. 

 

Stop video here and ask students to open writer file as shown in the video and 

then play the video again. 

 

123. To stop video time at 2 minute 20 seconds in VLC Media Player. 

 

Stop video here and ask students to type the paragraph as shown in video. 

Now just check and play the video again.  

 

124. To stop video time at 2 minute 32 seconds in VLC Media Player. 
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Stop video here and check whether they have typed out the paragraph or not and 

then play the video again. 

 

125. To stop video time at 2 minute 41 seconds in VLC Media Player. 

 

Stop video here and ask students to divide the paragraph in two parts and then 

play the video again. 

 

126. To stop video time at 3 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to bring the cursor on the middle of the 

paragraph and play the video again. 

 
127. To stop video time at 4 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Line Break’ option as shown in the 

video and then play the video again. 

 

128. To stop video time at 4 minute 44 seconds in VLC Media Player. 

Stop video here and ask students to click on ‘Page Break’ option as shown in 

the video and then play the video again. 

Now just check whether they’ve done ‘Manual Break’ or not, and play the video 

again. 

 

 

 

 

 

 

129. To stop video time at 4 minute 54 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Header’ and then play the 

video again. 

 
130. To stop video time at 5 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to insert Header as shown in the video and 

then play the video again. 

 

131. To stop video time at 6 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to type the name and date in the ‘Header box’ 

and then play the video again. 

 

132. To stop video time at 06 minute 07 seconds in VLC Media Player. 

 

Stop video here and ask students to open any file using ‘Hyperlink’ option and 

then play the video again. 

 

 
133. To stop video time at 06 minute 44 seconds in VLC Media Player. 
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Stop video and ask students to click on the Insert menu and then play the video 

again. 

 

134. To stop video time at 06 minute 55 seconds in VLC Media Player. 

Stop video and ask the students to click on the ‘Hyperlink’ option as shown in 

the video. 

Just check whether the box has appeared or not as shown in the video and then 

play the video again. 

 

135. To stop video time at 07 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to choose any file and then click the ‘open’ 

button as shown in the video. 

Just check and play the video again. 

 

136. To stop video time at 07 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Apply’ button and then 

followed by ‘Close’ button as shown in the video. 

Just check and play the video again. 

 

137. To stop video time at 08 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to open the Hyperlink as shown in the video . 

Now just check if everyone has done so and play the video again. 

 

138. To stop video time at 8 minute 36 seconds in VLC Media Player. 

 

Stop video here and ask students to insert the page number in the ‘Footer’ box 

and then play the video again. 
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139. To stop video time at 09 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Footer’ as shown in the video and 

then play the video again. 

 

140. To stop video time at 09 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to insert page number on the footer box as 

shown in the video and then play the video again. 

 

141. To stop video time at 10 minute 39 seconds in VLC Media Player. 

Stop video here and ask the students to draw the Star from the drawing bar as 

shown in the video. 

Just check and play the video again. 

 

142. To stop video time at 11 minute 54 seconds in VLC Media Player. 

Stop video here and ask the students to change the Shape formatting from the 

drawing bar as shown in the video. 

Just check whether they have changed formatting of drawing or not and play the 

video again. 

 

143. To stop video time at 12 minute 07 seconds in VLC Media Player. 

Stop video here and ask the students to save the file and then play the video 

again. 

 

144. To stop video time at 12 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to click on the file menu as shown in the video 

and then play the video again. 

 

145. To stop video time at 13 minute 04 seconds in VLC Media Player. 

Stop video here and check whether they’ve clicked on save submenu and the 

box has appeared or not as shown in the video. 

Just check and play the video again. 

 

 

146. To stop video time at 13 minute 56 seconds in VLC Media Player. 
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Stop video here and ask students to type their name in the file name box as 

shown in the video and then play the video again. 

 

147. To stop video time at 14 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to click on save option as shown in video and 

then play the video again.  

 

148. To stop video time at 14 minute 22 seconds in VLC Media Player. 

Stop video here and check whether they have saved writer file or not and then 

play the video again. 

 

149. To stop video time at 14 minute 28 seconds in VLC Media Player. 

 

Stop video here and ask students to shutdown the computer and then play the 

video again. 
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Complete teacher’s manual for Writer 2 Class 5 

Summaries 

 

 Open your laptop/notebook and switch on. 

 How to open Writer file and operate it. 

 What is manual break? 

 How to do page break? 

 How to use characters option? 

 How to use effects, font effects etc.? 

 Why do we use default formatting? 

 How to Close Writer file. 

 How to shut down computer. 

Now let’s start class. 

 

150. To stop video time at 23 seconds in VLC Media Player. 

  

Stop video here and ask which sub menu is used for inserting ‘date and time’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

151. To stop video time at 33 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘header and footer’? 

Just listen to the answers and play the video again for the correct answer. 

 

152. To stop video time at 50 seconds in VLC Media Player. 

 

Stop video here and ask them how many files can be inserted using hyperlink? 

Just listen to the answers and play the video again for the correct answer. 

 

153. To stop video time at 1 minute 03 seconds in VLC Media Player. 

 

Stop video here and ask them if they know how to open ‘hyperlink file’? 

Just listen to the answers and play the video again for the correct answer. 
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154. To stop video time at 1 minute 28 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell what is standard tool bar? 

Just listen to the answers and play the video again for the correct answer. 

 

155. To stop video time at 1 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again? 

 

156. To stop video time at 2 minute 52 seconds in VLC Media Player. 

Stop video here and check whether they’ve opened writer file or not and then 

play the video again. 

 

157. To stop video time at 3 minute 23 seconds in VLC Media Player. 
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Stop video here and ask, what will we learn today? 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

158. To stop video time at 3 minute 20 seconds in VLC Media Player. 

 

Stop video here and ask students to type the paragraph as shown in video? 

Now just check and play the video again.  

 

159. To stop video time at 3 minute 34 seconds in VLC Media Player. 
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Stop video here and check whether they’ve typed out the paragraph and then 

play the video again. 

 

160. To stop video time at 3 minute 47 seconds in VLC Media Player. 

 

Stop video here and ask why we use ‘character sub menu’? 

Just listen to the answers and play the video again for the correct answer. 

 

161. To stop video time at 05 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

162. To stop video time at 5 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to click ‘Format’ menu and then click on the 

‘Characters’ sub menu as shown in the video and then play the video again.  

 

163. To stop video time at 6 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to change the font name as shown in the video 

and then play the video again. 

Now just check and play the video again. 

 

164. To stop video time at 6 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

165. To stop video time at 7 minute 11 seconds in VLC Media Player. 
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Stop video here and ask students to click ‘Format’ menu and then click on the 

‘Characters’ sub menu as shown in the video and then play the video again.  

 

166. To stop video time at 07 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to do ‘Bold’ and ‘Italic’ as shown in the video 

and then play the video again. 

 

167. To stop video time at 07 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to apply ‘bold’ and ‘italics’ as shown in the 

video  

Now just check and play the video again. 

 

168. To stop video time at 08 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

169. To stop video time at 08 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to click ‘Format’ menu and then click on the 

‘Characters’ sub menu as shown in the video and then play the video again.  

 

170. To stop video time at 08 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘font size’ as shown in the video 

and then play the video again. 

Now just check and play the video again. 

 

171. To stop video time at 09 minute 18 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what happens with ‘Font color’? 

Just listen to the answers and play the video again for the correct answer. 

 

172. To stop video time at 10 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

173. To stop video time at 10 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

174. To stop video time at 11 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘color’ as shown in the video 

and then play the video again. 

Now just whether they have changed the font color or not and play the video 

again. 

 

175. To stop video time at 11 minute 05 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Effects’? 

Just listen to the answers and play the video again for the correct answer. 

 

176. To stop video time at 11 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 
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177. To stop video time at 12 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

178. To stop video time at 13 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to do all the lines in Capital letter as shown in 

the video and then play the video again. 

 

179. To stop video time at 13 minute 22 seconds in VLC Media Player. 

 
Stop video here and ask them if they can tell why we use ‘outline’ in the 

‘Writer’? 

Just listen to the answers and play the video again for the correct answer. 

 

180. To stop video time at 13 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

181. To stop video time at 14 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

182. To stop video time at 14 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘outline’ as shown in the video 

and then play the video again. 

 

183. To stop video time at 15 minute 18 seconds in VLC Media Player. 
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Stop video here and ask students to do normal in text as shown in the video and 

then play the video again. 

 

 

184. To stop video time at 15 minute 22 seconds in VLC Media Player. 

 

Stop video here and ask what is ‘Shadow’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

185. To stop video time at 15 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

186. To stop video time at 16 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

187. To stop video time at 16 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Shadow as shown in the video 

and then play the video again. 

 

188. To stop video time at 17 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to remove the shadow from the lines as shown 

in the video. 

Now just check whether they’ve removed the ‘Shadow’ or not then play the 

video again. 

 

189. To stop video time at 17 minute 35 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what is ‘blinking’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

190. To stop video time at 18 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

191. To stop video time at 18 minute 39 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

192. To stop video time at 19 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘blinking’ as shown in the video.  

Just check whether they’ve applied ‘blinking’ or not and then play the video 

again. 

 

193. To stop video time at 21 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to remove the ‘Blinking’ option as shown in 

the video and then play the video again. 

 

194. To stop video time at 21 minute 18 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘hidden’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

195. To stop video time at 22 minute 03 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

196. To stop video time at 22 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

197. To stop video time at 22 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘hidden’ as shown in the video.  

Just check whether they’ve applied ‘hidden’ or not and then play the video 

again. 

 

198. To stop video time at 23 minute 41 seconds in VLC Media Player. 

Stop video here and ask students to bring back paragraph which they had hidden 

as shown in the video and then play the video again. 

 

 

199. To stop video time at 23 minute 53 seconds in VLC Media Player. 
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Stop video here and ask if they know what is ‘Over lining’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

200. To stop video time at 24 minute 51 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again. 

 

201. To stop video time at 25 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ option and then click 

on the ‘Characters’ sub menu and then play the video again. 

 

202. To stop video time at 26 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘over lining’ as shown in the 

video.  

Just check whether they’ve applied ‘over lining’ or not and then play the video 

again. 

 

203. To stop video time at 26 minute 46 seconds in VLC Media Player. 

Stop video here and ask students to change the over lining as shown in the video 

and then play the video again.  

  

 

 

 

204. To stop video time at 26 minute 59 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘strikethrough’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

205. To stop video time at 28 minute 37 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Strikethrough’ as shown in the 

video.  

Just check whether they’ve applied ‘Strikethrough’ or not and then play the 

video again. 

 

206. To stop video time at 29 minute 07 seconds in VLC Media Player. 

Stop video here and ask students to remove the ‘Strikethrough’ from the 

paragraph as shown in the video and then play the video again. 

 

207. To stop video time at 29 minute 15 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Underline’? 

Just listen to the answers and play the video again for the correct answer. 

 

208. To stop video time at 31 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘underline’ as shown in the video.  
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Just check whether they’ve applied ‘underline’ or not and then play the video 

again. 

209. To stop video time at 32 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to change the underline color as shown in the 

video and then play the video again. 

 

210. To stop video time at 32 minute 20 seconds in VLC Media Player. 

 

Stop video here and ask if they know what happens with ‘background ‘option? 

Just listen to the answers and play the video again for the correct answer. 

 

211. To stop video time at 32 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

212. To stop video time at 33 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘background color’ of the 

paragraph as show in the video. 

Now just check and play the video again. 

 

213. To stop video time at 33 minute 42 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what happens with ‘default formatting’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

214. To stop video time at 35 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘default formatting’ as shown in the 

video and then play the video again. 

 

215. To stop video time at 35 minute 27 seconds in VLC Media Player. 

 

Stop video here and ask the students to close the writer file and then shut down 

the computer. 

Just check whether they have shut down the computer or not. 

 

 

 

 

 

 

 

 



   

  57 
 

Complete teacher’s manual for Writer 2 Class 6 

Summaries 

 

 Open your laptop/notebook and switch on. 

 How to open Writer file and operate it. 

 What is manual break? 

 How to do page break? 

 How to use characters option? 

 How to use effects, font effects etc.? 

 Why we use default formatting? 

 How to use line and spacing? 

 How to insert drop caps? 

 How to insert border? 

 How to Close Writer file. 

 How to shut down computer. 

Now let’s start class. 

216. To stop video time at 30 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell, what is ‘Default Formatting’? 

Just listen to the answers and play the video again for the correct answer. 

217. To stop video time at 52 seconds in VLC Media Player. 
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Stop video here and ask if they know why we use ‘Character’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

218. To stop video time at 1 minute 37 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again. 

 

219. To stop video time at 1 minute 53 seconds in VLC Media Player. 

 

Stop video here and ask students to type the paragraph as shown in video? 

Now just check and play the video again.  
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220. To stop video time at 2 minute 12 seconds in VLC Media Player. 

 
Stop video here and ask if they have typed out the paragraph? 

Just listen to the answers and play the video again for the correct answer. 

 

221. To stop video time at 2 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

222. To stop video time at 2 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ menu and select the 

‘Characters’ submenu and then play video again. 

 

223. To stop video time at 3 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to change the font style as shown in the video 

and then play the video again. 

 

224. To stop video time at 4 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to select the line as shown in the video. 

Just check whether they’ve selected the paragraph or not and then play the 

video again.  

 

225. To stop video time at 4 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ menu and select the 

‘Characters’ submenu and then play video again. 

 

226. To stop video time at 5 minute 25 seconds in VLC Media Player. 
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Stop video here and ask students to change the ‘Font size’ of the line as shown 

in the video and then play the video again. 

Now just check whether they have changed the font size or not and then play 

the video again. 

 

 

227. To stop video time at 5 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to change font color and then play the video 

again. 

 

228. To stop video time at 6 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to select the line or paragraph as shown in the 

video. 

Just check whether they’ve selected the line/paragraph or not and then play the 

video again. 

 

229. To stop video time at 6 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ menu and select the 

‘Characters’ submenu and then play video again. 

 

230. To stop video time at 6 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘Font Color’ as shown in the 

video and then play the video again. 

Now just check whether they have changed the font color or not and then play 

the video again. 

 

 



   

  61 
 

 

231. To stop video time at 6 minute 53 seconds in VLC Media Player. 

 
Stop video here and ask students to make third line blinking and then play the 

video again. 

 

232. To stop video time at 7 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to select the line or paragraph as shown in the 

video. 

 

233. To stop video time at 7 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

234. To stop video time at 8 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to make the line ‘Blinking’ as shown in the 

video. 

Just check whether students have made the line blinking or not and then play the 

video again. 

  

235. To stop video time at 8 minute 17 seconds in VLC Media Player. 
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Stop video here and ask students to practice the ‘Effects’ then play the video 

again. 

 

236. To stop video time at 8 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to select the remaining line as shown in the 

video and then play the video again. 

 

237. To stop video time at 9 minute 19 seconds in VLC Media Player. 

Stop video here and check whether students have used the ‘Effects’ or not and 

then play the video again. 

 

238. To stop video time at 9 minute 27 seconds in VLC Media Player. 

 

Stop video here and ask if they know why we use ‘Paragraph’ sub menu? 

Just listen to the answers and play the video again for the correct answer. 

 

239. To stop video time at 10 minute 18 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Indent and Spacing’? 

Just listen to the answers and play the video again for the correct answer. 

 

 

240. To stop video time at 11 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu and then click on 

the ‘Indent and Spacing’ option as shown in the video and then play the video 

again.  

 

241. To stop video time at 12 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to use ‘Before Text’ option as shown in video 

and then play the video again. 

 

242. To stop video time at 13 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to do normal as shown in the video and then 

play the video again. 

 

243. To stop video time at 13 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to use ‘After Text’ option as shown in video 

and then play the video again. 

 

244. To stop video time at 13 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to do normal as shown in the video and then 

play the video again. 

 

245. To stop video time at 15 minute 32 seconds in VLC Media Player. 
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Stop video here and ask students to use ‘Above Paragraph and Below 

Paragraph’ option as shown in video and then play the video again. 

 

246. To stop video time at 16 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Line spacing’ as shown in the video 

and then play the video again. 

 

247. To stop video time at 16 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to bring paragraph back in the normal as 

shown in the video. 

Now Just check just check whether have used the ‘Indent and spacing’ option or 

not and then play the video again. 

 

 

248. To stop video time at 16 minute 44 seconds in VLC Media Player. 

 
Stop video here and ask if they know why we use ‘Alignment’? 

Just listen to the answers and play the video again for the correct answer. 

 

249. To stop video time at 18 minute 45 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Alignment’ as shown in the video. 

Now just check and play the video again. 

 

250. To stop video time at 18 minute 56 seconds in VLC Media Player. 
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Stop video here and ask if they can tell why we use ‘Drop Caps’? 

Just listen to the answers and play the video again for the correct answer. 

 

251. To stop video time at 20 minute 24 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Paragraph’ option as shown in the video and then play the video again. 

 

252. To stop video time at 22 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Drop Caps’ as shown in the video 

and then play the video again. 

 

253. To stop video time at 23 minute 47 seconds in VLC Media Player. 

Stop video here and check whether they have used ‘Drop caps’ or not and then 

play the video again. 

 

254. To stop video time at 23 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Border’ option? 

Just listen to the answers and play the video again for the correct answer. 
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255. To stop video time at 24 minute 56 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the paragraph option as shown in the video and then play the video again. 

 

256. To stop video time at 27 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Border’ on the paragraph as 

shown in the video and then play the video again. 

 

257. To stop video time at 27 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to click once again in the ‘Border’ option as 

shown in the video and then play the video again. 

 

258. To stop video time at 29 minute 33 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Space and content’ of the ‘Border’ 

as shown in the video and then play the video again. 

 

259. To stop video time at 31 minute 30 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Shadow’ option of the ‘Border’ 

shown in the video. 

Now just check whether they have used the all options of ‘Border’ or not and 

then play the video again. 

  

To stop video time at 31 minute 40 seconds in VLC Media Player. 

 

Stop video here and ask the students to close the writer file and then shut down 

the computer. 

Just check whether they have shut down the computer or not. 
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Complete teacher’s manual for Writer 2 Class 7 

Summaries 

 

 Open your laptop/notebook and switch on 

 How to open Writer file and operate it. 

 Why we use default formatting? 

 How to use line and spacing? 

 How to insert numbering and bullets? 

 How to set margin on the page? 

 How to change page background? 

 How to insert header and footer 

 How to insert border on the writer page 

 How to Close Writer file. 

 How to shut down computer. 

Now let’s start class. 

 

260. To stop video time at 26 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell how to remove ‘Text Boundaries’? 

Just listen to the answers and play the video again for the correct answer. 

 

261. To stop video time at 35 seconds in VLC Media Player. 



   

  68 
 

 
Stop video here and ask if they can tell why we use ‘Default Formatting’? 

Just listen to the answers and play the video again for the correct answer. 

 

262. To stop video time at 1 minute 12 seconds in VLC Media Player. 

 
Stop video here and ask why we use ‘Paragraph’ submenu option? 

Just listen to the answers and play the video again for the correct answer. 

 

263. To stop video time at 1 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file as shown in video and then 

play the video again. 
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264. To stop video time at 2 minute 24 seconds in VLC Media Player. 

 
Stop video here and ask, what will we learn today? 

Just listen to the answers and play the video again for the correct answer. 

 

265. To stop video time at 2 minute 33 seconds in VLC Media Player. 

 
Stop video here and ask students to type the line and also ask them to do copy 

and paste ten times and then play the video again. 

 

266. To stop video time at 3 minute 02 seconds in VLC Media Player. 

Stop video here and ask students to select the line as shown in video and then 

play the video again. 

 

267. To stop video time at 3 minute 48 seconds in VLC Media Player. 

Stop video here and ask students to do copy and paste by shortcut command as 

shown in video and then play the video again. 

 

268. To stop video time at 4 minute 41 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in video. 
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Now just check whether they have copied or pasted ten times or not and then 

play the video again.  

 

269. To stop video time at 5 minute 01 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use ‘Bullets and Numbering’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

270. To stop video time at 6 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Bullets and numbering’ option as shown in the video and then play the 

video again. 

 

271. To stop video time at 6 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Bullets’ on the first line as shown 

in the video and then play the video again. 

 

272. To stop video time at 6 minute 34 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Numbering’ on the second line as 

shown in the video and then play the video again. 

 

273. To stop video time at 8 minute 49 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘graphics’ on the third and fourth 

line as shown in the video and then play the video again. 

 

274. To stop video time at 9 minute 57 seconds in VLC Media Player. 
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Stop video here and ask students to remove ‘Bullets and Numbering’ as 

explained in the video. 

Now just check whether they’ve removed the ‘Bullets and Numbering or not 

and then play the video again. 

  

 

 

275. To stop video time at 11 minute 11 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then select 

the ‘Page’ submenu and then play the video again. 

 

276. To stop video time at 12 minute 13 seconds in VLC Media Player. 

Stop video here and ask students to change the Paper format as shown in the 

video. 

Now just check whether they’ve changed Page format or not and then play the 

video again. 

 

277. To stop video time at 13 minute 04 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Orientation’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

278. To stop video time at 13 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Page’ option as shown in the video and then play the video again. 

 

279. To stop video time at 14 minute 10 seconds in VLC Media Player. 
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Stop video here and ask students to change ‘Orientation’ of the page as shown 

in the video and then play the video again. 

 

280. To stop video time at 14 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do in ‘Portrait’ format as shown in the video 

and then play the video again. 

 

 

 

 

281. To stop video time at 14 minute 32 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Page Background’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

282. To stop video time at 15 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ menu and then click 

on the ‘Page submenu’ and then play the video again. 

 

283. To stop video time at 16 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘Page Background’ as shown in 

the video. 

Now just check whether they’ve changed page background or not and then play 

the video again. 

 

284. To stop video time at 16 minute 54 seconds in VLC Media Player. 
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Stop video here and ask students to set the picture in the background of the page 

as shown in the video. 

Now just check whether they’ve set the picture in the background or not and 

then play the video again. 

 

 

 

285. To stop video time at 17 minute 07 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Header and Footer’? 

Just listen to the answers and play the video again for the correct answer. 

 

286. To stop video time at 18 minute 20 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu’ and then click 

on the ‘Page’ option as shown in the video and then play the video again. 

 

287. To stop video time at 18 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to insert header as shown in the video and then 

play the video again. 

 

288. To stop video time at 19 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to set left margin of header as shown in the 

video and then play the video again. 

 

289. To stop video time at 20 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to do spacing of header as shown in the video 

and then play the video again. 
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290. To stop video time at 20 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to set height of header as shown in the video 

and then play the video again. 

 

291. To stop video time at 21 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to type name or title as shown in video. 

Now just check whether they’ve typed or not and then play the video again. 

 

 

292. To stop video time at 22 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to insert footer as shown in the video and then 

play the video again. 

 

293. To stop video time at 23 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to set right margin of footer as shown in the 

video and then play the video again. 

 

294. To stop video time at 23 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to do spacing of footer as shown in the video 

and then play the video again. 

Now just check and play the video again. 

 

295. To stop video time at 24 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to set height of footer as shown in the video 

and then play the video again. 

 

296. To stop video time at 24 minute 32 seconds in VLC Media Player. 

Stop video here and ask students to insert a page number as shown in video. 

Now just check whether they’ve inserted page number or not and then play the 

video again. 

 

297. To stop video time at 24 minute 45 seconds in VLC Media Player. 
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Stop video here and ask why we use ‘Page Border’? 

Just listen to the answers and play the video again for the correct answer. 

 

 

298. To stop video time at 27 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Page Borders’ as shown in the 

video. 

Now just check whether they’ve applied ‘Page Border’ or not and then play the 

video again. 

 

299. To stop video time at 28 minute 59 seconds in VLC Media Player. 

Stop video here and ask students to use the ‘Spacing to contents’ as shown in 

the video. 

Now just check whether they’ve used ‘Spacing to contents’ or not and then play 

the video again. 

 

300. To stop video time at 29 minute 29 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

 

301. To stop video time at 31 minute 16 seconds in VLC Media Player. 

Stop video here and ask students to do as shown in the video and then play the 

video again. 

Now just check whether they have applied shadow or not and play the video 

again. 

 

302. To stop video time at 31 minute 36 seconds in VLC Media Player. 
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Stop video here and ask the students to close the writer file and then shut down 

the computer. 

Just check whether they have shut down the computer or not. 
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Complete teacher’s manual for Writer 2 Class 8 

Summaries 

 

 Open your laptop/notebook and switch on 

 How to open Writer file and operate it. 

 How to use character sub menu 

 How to use indent and spacing? 

 How to insert numbering and bullets? 

 How to change page background? 

 How to insert header and footer 

 How to insert border on the writer page 

 How to Close Writer file. 

 How to shut down computer. 

Now let’s start class. 

303. To stop video time at 27 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use ‘Bullets and Numbering’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

304. To stop video time at 1 minute 01 seconds in VLC Media Player. 
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Stop video here and ask if they can tell how to set ‘Page Margin’ on the writer 

page? 

Just listen to the answers and play the video again for the correct answer. 

 

305. To stop video time at 1 minute 26 seconds in VLC Media Player. 

 

Stop video here and ask if they know which submenu helps us to change text 

‘Background Color’? 

Just listen to the answers and play the video again for the correct answer. 

 

306. To stop video time at 1 minute 43 seconds in VLC Media Player. 
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Stop video here and ask if they can tell what happens with use of ‘Page 

Background’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

 

307. To stop video time at 2 minute 05 seconds in VLC Media Player. 

 
 

Stop video here and ask if they can tell what happens with use of  Page ‘Border’ 

option ? 

Just listen to the answers and play the video again for the correct answer. 

 

308. To stop video time at 2 minute 50 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again? 

 

309. To stop video time at 3 minute 24 seconds in VLC Media Player. 
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Stop video here and ask if they all been able to open writer file? 

Just listen to the answers and play the video again. 

 

310. To stop video time at 3 minute 38 seconds in VLC Media Player. 

 

Stop video here and ask students to type the paragraph as shown in video.  

Now just check whether they have typed out the paragraph or not and play the 

video again.  

 

311. To stop video time at 3 minute 57 seconds in VLC Media Player. 

 



   

  81 
 

Stop video here and ask students to change the size of the paragraph by using 

‘Character’ submenu and then play the video again. 

 

312. To stop video time at 4 minute 04 seconds in VLC Media Player. 

 
Stop video here and ask students to change the ‘Font Name’ and also apply over 

line on the paragraph and then play the video again. 

 

313. To stop video time at 4 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

314. To stop video time at 4 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format’ menu and then click 

on the ‘Characters submenu’ as shown in the video and then play the video 

again. 

 

315. To stop video time at 5 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to change the font name as shown in the video 

and then play the video again. 

 

316. To stop video time at 6 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

317. To stop video time at 7 minute 08 seconds in VLC Media Player. 

Stop video here and ask students to change the ‘Font Size’ as shown in the 

video. 
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Now just check whether they’ve changed the ‘Font Size’ or not and then play 

the video again. 

 

318. To stop video time at 8 minute 26 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Over lining’ on the paragraph as 

shown in the video. 

Now just check whether they’ve applied the ‘Over lining’ or not and then play 

the video again. 

 

 

319. To stop video time at 8 minute 48 seconds in VLC Media Player. 

 

Stop video here and ask students to do practice of ‘font color’, ‘small caps’ and 

‘under-lining’. 

 

320. To stop video time at 9 minute 17 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

321. To stop video time at 9 minute 59 seconds in VLC Media Player. 

Stop video here and ask students to change the font color as shown on the video. 

Now just check whether they have changed the font color or not and then play 

the video again. 

 

322. To stop video time at 11 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to make the paragraph in small capitals as 

shown in video and then play the video again. 
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323. To stop video time at 12 minute 05 seconds in VLC Media Player. 

Stop video here and ask students to apply underline on the paragraph as shown 

in the video. 

Now just check whether they have applied underline or not and then play the 

video again. 

 

324. To stop video time at 12 minute 27 seconds in VLC Media Player. 

 

Stop video here and ask students to practice ‘Indent and Spacing’, ‘Drop caps’ 

and ‘Border’ option and then play the video again. 

 

325. To stop video time at 12 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

326. To stop video time at 14 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do practice of ‘Indent and Spacing’ as 

shown in the video and then play the video again. 

 

327. To stop video time at 16 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to do practice of ‘Indent and Spacing’ as 

shown in the video and then play the video again. 

 

328. To stop video time at 16 minute 09 seconds in VLC Media Player. 
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Stop video here and ask students to do practice of ‘Bullets and Numbering’ and 

then play the video again. 

 

 

329. To stop video time at 18 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Bullets and Numbering as shown 

in the video. 

Now just check whether they have applied ‘Numbering and Bullets or not and 

then play the video again. 

 

330. To stop video time at 18 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask students to put date in ‘Header’ and insert the page 

number in ‘Footer’ and then play the video again. 

 

331. To stop video time at 19 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Format menu ‘and then click 

on the ‘Page’ option as shown in the video and then play the video again. 

 

332. To stop video time at 20 minute 16 seconds in VLC Media Player. 
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Stop video here and ask students to insert the ‘Header’ as shown in the video 

and then play the video again. 

 

333. To stop video time at 20 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to insert the date in the header box as shown in 

the video. 

Now just check whether they have inserted the date in the ‘Header box’ or not 

and then play the video again. 

 

334. To stop video time at 22 minute 18 seconds in VLC Media Player. 

Stop video here and ask students to insert the ‘Footer’ as shown in the video and 

then play the video again. 

 

 

335. To stop video time at 22 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to insert the page number in the footer box as 

shown in the video. 

Now just check whether they have inserted the page number in the footer box or 

not and then play the video again. 

 

336. To stop video time at 22 minute 58 seconds in VLC Media Player. 

 
Stop video here and ask students to change the background of the page and then 

play the video again. 

 

337. To stop video time at 24 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to change the background of the page as 

shown in video and then play the video again. 
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338. To stop video time at 24 minute 23 seconds in VLC Media Player. 

 

Stop video here and ask the students to save the writer file and then shut down 

the computer. 

Just check whether they have shut down the computer or not. 
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Complete teacher’s manual for Writer 2 Class 9 

Summaries 

 

 Open your laptop/notebook and switch on? 

 How to open Writer file and operate it? 

 Why we use Change case? 

 What is table? 

 What is row and column? 

 How to insert table? 

 What is merge cell? 

 What is split cell? 

 How to use table option? 

 How to change table design? 

 How to Close Writer file? 

 How to shut down computer? 

Now let’s start class. 

 

 

339. To stop video time at 17 seconds in VLC Media Player. 

 

Stop video here and ask, if they can tell there are how many types of ‘Page 

Orientation’? 

Just listen to the answers and play the video again for the correct answer. 
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340. To stop video time at 28 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use ‘Drop Caps’? 

Just listen to the answers and play the video again for the correct answer. 

 

341. To stop video time at 43 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell why we use ‘Blinking’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

342. To stop video time at 1 minute 05 seconds in VLC Media Player. 
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Stop video here and ask students to open the ‘Writer file and then play the video 

again? 

 

343. To stop video time at 1 minute 50 seconds in VLC Media Player. 

 

Stop video here and ask, what will we learn today? 

Just listen to the answers and play the video again for the correct answer. 

 

344. To stop video time at 1 minute 55 seconds in VLC Media Player. 

 

Stop video here and ask students to type the paragraph as shown in video. 

Now just check and play the video again.  
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345. To stop video time at 2 minute 29 seconds in VLC Media Player. 

 

Stop video here and ask if they know what happens with ‘Lower Case’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

346. To stop video time at 3 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

347. To stop video time at 3 minute 36 seconds in VLC Media Player. 

Stop video here and ask students to change the paragraph in ‘Lower Case’ as 

shown in the video. 

Now just check if everyone has done so and play the video again. 

 

348. To stop video time at 3 minute 44 seconds in VLC Media Player. 

 

Stop video here and ask if they know what is ‘Sentence Case’ option?  

Just listen to the answers and play the video again for the correct answer. 

 

349. To stop video time at 4 minute 16 seconds in VLC Media Player. 
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Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

350. To stop video time at 4 minute 54 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Sentence Case’ as shown in the 

video. 

Now just check if everyone has done so and play the video again. 

 

 

 

 

 

 

 

 

351. To stop video time at 5 minute 02 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Upper Case’?  

Just listen to the answers and play the video again for the correct answer. 

 

352. To stop video time at 5 minute 40 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

353. To stop video time at 6 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to change the paragraph into ‘Upper Case’ as 

shown in the video. 

Now just check if everyone has done so and play the video again. 
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354. To stop video time at 6 minute 23 seconds in VLC Media Player. 

 

Stop video here and ask if they can tell what happens with ‘Capitalize Every 

Word’ option?  

Just listen to the answers and play the video again for the correct answer. 

 

 

 

355. To stop video time at 7 minute 06 seconds in VLC Media Player. 

Stop video here and ask students to select the paragraph as shown in the video 

and then play the video again. 

 

356. To stop video time at 7 minute 42 seconds in VLC Media Player. 

Stop video here and ask students to change the paragraph into ‘Capitalize Every 

Word’ as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

357. To stop video time at 7 minute 51 seconds in VLC Media Player. 

 

Stop video here and ask if they know why we use ‘Toggle Case’?  
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Just listen to the answers and play the video again for the correct answer. 

 

358. To stop video time at 8 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to apply the ‘Toggle Case’as shown in the 

video. 

Now just check if everyone has done so and play the video again. 

 

359. To stop video time at 9 minute 31 seconds in VLC Media Player. 

 

Stop video here and ask if they know what is ‘Table’?  And why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

360. To stop video time at 10 minute 04 seconds in VLC Media Player. 

 

Stop video here and ask them, if they know what is ‘Row and Column’? 

Just listen to the answers and play the video again for the correct answer. 

 

361. To stop video time at 10 minute 38 seconds in VLC Media Player. 
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Stop video here and ask if they know how to insert a ‘Table’ and how many 

methods are there to insert a ‘Table’? 

Just listen to the answers and play the video again for the correct answer. 

 

362. To stop video time at 12 minute 01 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Table’ menu as shown in the 

video and then play the video again. 

 

363. To stop video time at 13 minute 12 seconds in VLC Media Player. 

Stop video here and ask students to insert a table as shown in the video and then 

play the video again. 

 

 

364. To stop video time at 14 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to type the titles in the table as shown in the 

video and then play the video again. 

 

365. To stop video time at 15 minute 15 seconds in VLC Media Player. 

Stop video here and ask students to type out the names in the table as shown in 

the video. 

Now just check whether they’ve typed the names or not and then play the video 

again. 

 

366. To stop video time at 15 minute 47 seconds in VLC Media Player. 

Stop video here and ask students to type out the ‘roll number’ in the table as 

shown in the video. 
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Now just check whether they’ve typed the ‘roll number’ or not and then play the 

video again. 

 

367. To stop video time at 17 minute 04 seconds in VLC Media Player. 

Stop video here and ask students to type out the data as shown in the video. 

Now just check whether they’ve typed out the data or not and then play the 

video again. 

 

368. To stop video time at 17 minute 09 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell how to insert ‘row’? 

Just listen to the answers and play the video again for the correct answer. 

 

369. To stop video time at 18 minute 35 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Table’ menu and then click on 

the ‘Row’ option as shown in the video and then play the video again. 

 

370. To stop video time at 19 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to insert a row as shown in the video. 

Now just check whether they have inserted a row or not and then play the video 

again. 

 

371.  To stop video time at 20 minute 19 seconds in VLC Media Player. 

Stop video here and ask students to type the data in the new row as shown in the 

video and then play the video again. 

 

372. To stop video time at 20 minute 24 seconds in VLC Media Player. 
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Stop video here and ask if they can tell how to ‘insert column’? 

Just listen to the answers and play the video again for the correct answer. 

 

373. To stop video time at 22 minute 09 seconds in VLC Media Player. 

Stop video here and ask students to insert a column as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

374.  To stop video time at 22 minute 33 seconds in VLC Media Player. 

Stop video here and ask if they know how delete option is used?  

Just listen to the answers and play the video again for the correct answer. 

 

375. To stop video time at 23 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to delete the row as shown in the video and 

then play the video again. 

 

376. To stop video time at 23 minute 57 seconds in VLC Media Player. 

Stop video here and ask students to delete a ‘column’ as shown in video.  

Now just check and play the video again. 

 

377. To stop video time at 24 minute 15 seconds in VLC Media Player. 

Stop video here and ask if they know why we use select option? 

Just listen to the answers and play the video again for the correct answer. 

 

378. To stop video time at 24 minute 55 seconds in VLC Media Player. 

Stop video here and ask students to select the ‘table’ as shown in video.  

Now just check and play the video again. 
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379. To stop video time at 25 minute 25 seconds in VLC Media Player. 

Stop video here and ask students to select a ‘row’ as shown in video.  

Now just check and play the video again. 

 

380. To stop video time at 25 minute 55 seconds in VLC Media Player. 

Stop video here and ask students to select a ‘column’ as shown in video.  

Now just check and play the video again. 

 

381. To stop video time at 26 minute 14 seconds in VLC Media Player. 

Stop video here and ask students to select a ‘cell’ as shown in video.  

Now just check and play the video again. 

 

382. To stop video time at 26 minute 21 seconds in VLC Media Player. 

 

Stop video here and ask them if they know what is ‘merge cell’? 

Just listen to the answers and play the video again for the correct answer. 

 

383. To stop video time at 27 minute 27 seconds in VLC Media Player. 

Stop video here and ask students to select the row as shown in the video and 

then play the video again. 

 

384. To stop video time at 27 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to ‘merge’ the row as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

385. To stop video time at 28 minute 04 seconds in VLC Media Player. 
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Stop video here and ask them if they know what is the meaning of ‘split’?  

Just listen to the answers and play the video again for the correct answer. 

 

386. To stop video time at 30 minute 50 seconds in VLC Media Player. 

Stop video here and ask students to do ‘Split’ as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

387. To stop video time at 28 minute 46 seconds in VLC Media Player. 

Stop video here and ask students, if they know, how to to get total in a Table? 

Just listen to the answer and play the video again. 

 

388. To stop video time at 30 minute 59 seconds in VLC Media Player. 

Stop video here and ask if they know why we ‘Auto format’? 

Just listen to the answers and play the video again for the correct answer. 

 

389. To stop video time at 32 minute 23 seconds in VLC Media Player. 

Stop video here and ask students to change the design of the table as shown in 

the video and then play the video again. 

 

 

 

 

390. To stop video time at 32 minute 40 seconds in VLC Media Player. 
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Stop video here and ask the students to close the writer file and then shut down 

the computer. 

Just check whether they have shut down the computer or not. 
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Complete teacher’s manual for Writer 2 Class 10 

Summaries 

 

 Open your laptop/notebook and switch on 

 How to open Writer file and operate it. 

 What is table? 

 What is row and column? 

 How to insert table? 

 What is merge cell? 

 What is split cell? 

 How to use table option? 

 How to change table design? 

 How to Close Writer file. 

 How to shut down computer. 

Now let’s start class. 

391. To stop video time at 32 seconds in VLC Media Player. 

 
Stop video here and ask if they know the differences between ‘Upper Case’ and 

‘lower case’? 

Just listen to the answers and play the video again for the correct answer. 

392. To stop video time at 55 seconds in VLC Media Player. 
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Stop video here and ask if they know what happens with ‘Capitalize Every 

Word’ option? 

Just listen to the answers and play the video again for the correct answer. 

 

393. To stop video time at 1 minute 11 seconds in VLC Media Player. 

 

Stop video here and ask if they know what is ‘Table’ and why we use it? 

Just listen to the answers and play the video again for the correct answer. 

 

394. To stop video time at 1 minute 46 seconds in VLC Media Player. 
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Stop video here and ask them if they know what happens with ‘Merge Cell’ 

option? 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

 

 

 

 

 

395. To stop video time at 2 minute 03 seconds in VLC Media Player. 

 

Stop video here and ask them if they know what happens with ‘Split Cell’ 

option. 

Just listen to the answers and play the video again for the correct answer. 

 

396. To stop video time at 2 minute 43 seconds in VLC Media Player. 

 
Stop video here and ask students to open writer file and then play the video 

again. 
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397. To stop video time at 3 minute 01 seconds in VLC Media Player. 

 
Stop video here and ask students to create 5*5 Table and add students’ details in 

it and then play the video again. 

 

398. To stop video time at 4 minute 28 seconds in VLC Media Player. 

Stop video here and ask students to click on the ‘Table’ menu and then click on 

the ‘Table’ option as shown in the video and then play the video again. 

 

399. To stop video time at 4 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to insert a table as shown in the video and then 

play the video again. 

 

400. To stop video time at 6 minute 00 seconds in VLC Media Player. 

Stop video here and ask students to type the titles in the first row as shown in 

the video and then play the video again. 

 

401. To stop video time at 7 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to type the data in the table as shown in the 

video and then play the video again. 

 

402. To stop video time at 8 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to type the data in the table as shown in the 

video. 

Now just check whether they have typed out the data or not then play the video 

again. 
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403. To stop video time at 9 minute 04 seconds in VLC Media Player. 

 

Stop video here and ask students to insert the row and then play the video again 

and then play the video again. 

 

404. To stop video time at 10 minute 40seconds in VLC Media Player. 

Stop video here and ask students to insert row as shown in the video.  

Now just check if everyone has done so and play the video again. 

 

405. To stop video time at 10 minute 54 seconds in VLC Media Player. 

 

Stop video here and ask students to merge the first row and type the school 

name in it and then play the video again. 

 

406. To stop video time at 11 minute 52 seconds in VLC Media Player. 

Stop video here and ask students to select the first row as shown in the video 

and then play the video again. 

 

407. To stop video time at 12 minute 21 seconds in VLC Media Player. 

Stop video here and ask students to merge the row as shown in the video and 

then play the video again. 
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Now just check and play the video again. 

 

408. To stop video time at 12 minute 58 seconds in VLC Media Player. 

Stop video here and ask students to type the school name as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

409. To stop video time at 13 minute 07 seconds in VLC Media Player. 

 

Stop video here and ask students to split the last column vertically and then play 

the video again. 

 

410. To stop video time at 15 minute 38 seconds in VLC Media Player. 

Stop video here and ask students to split cells as shown in the video. 

Now just check if everyone has done so and play the video again. 

 

411. To stop video time at 15 minute 45 seconds in VLC Media Player. 

 
Stop video here and ask students to change the design of the ‘Table’ and then 

play the video again. 

 

412. To stop video time at 17 minute 02 seconds in VLC Media Player. 
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Stop video here and ask students to change the design of the ‘Table’ as shown 

in the video. 

Now just check whether they have changed the design of the table or not and 

then play the video again. 

 

413. To stop video time at 17 minute 17 seconds in VLC Media Player. 

 

Stop video here and ask the students to save the writer file and then shut down 

the computer.Just check whether they have shut down the computer or not. 
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Complete teacher’s manual for Writer 2 Class 11 

Summaries 

 

 Open your laptop/notebook and switch on 

 How to open Writer file and operate it. 

 What is status bar? 

 What is header and footer? 

 Why we use hyperlink? 

 How to insert page border? 

 What is a table?  

 How to insert table? 

 What is merge cell? 

 What is split cell? 

 How to Close Writer file. 

 How to shut down computer. 

Now let’s start class. 

414. To stop video time at 37 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Status bar’? 

Just listen to the answers and play the video again for the correct answer. 

415. To stop video time at 1 minute 10 seconds in VLC Media Player. 
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Stop video here and ask if they know what are ‘Non-Printing Characters’ and how to 

hide non printing characters from the writer page? 

Just listen to the answers and play the video again for the correct answer. 

 

416. To stop video time at 1 minute 59 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Page Break’? 

Just listen to the answers and play the video again for the correct answer. 

 

417. To stop video time at 2 minute 23 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Hyperlink’ 

Just listen to the answers and play the video again for the correct answer. 
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418. To stop video time at 2 minute 54 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Default Formatting’? 

Just listen to the answers and play the video again for the correct answer. 

 

419. To stop video time at 3 minute 16 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what is ‘Table’ and why it is used?  

Just listen to the answers and play the video again for the correct answer. 

 

420. To stop video time at 3 minute 29 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Merge cells’?  

Just listen to the answers and play the video again for the correct answer. 
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421. To stop video time at 3 minute 48 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Split cells’?  

Just listen to the answers and play the video again for the correct answer. 

 

422. To stop video time at 4 minute 20 seconds in VLC Media Player. 

 
Stop video here and ask students to open the writer and then play the video again. 

 

423. To stop video time at 5 minute 23 seconds in VLC Media Player. 

Stop video here and check whether they have all opened the writer file or not and then 

play the video again. 

 

424. To stop video time at 5 minute 51 seconds in VLC Media Player. 
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Stop video here and ask students if they know what have they learnt in writer 2 

module? 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

 

 

425. To stop video time at 7 minute 06 seconds in VLC Media Player. 

 
Stop video here and ask students to do ‘copy and paste’ 10 times of the given line and 

then play the video again. 

 

426. To stop video time at 9 minute 22 seconds in VLC Media Player. 

Stop video here and ask students to do copy paste as shown in the video. 

Now check whether they’ve ‘copy pasted’ or not and then play the video again. 

 

427. To stop video time at 9 minute 26 seconds in VLC Media Player. 
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Stop video here and ask students to practice ‘Field option’ and then play the video 

again. 

428. To stop video time at 9 minute 32 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell why we use ‘Field option? 

Just listen to the answers and play the video again for the correct answer. 

 

429. To stop video time at 9 minute 53 seconds in VLC Media Player. 

 
Stop video here and ask students to insert date on the writer page and then play the 

video again. 

 

430. To stop video time at 10 minute 47 seconds in VLC Media Player. 
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Stop video here and ask students to insert date as shown in the video and then play the 

video again. 

 

431. To stop video time at 10 minute 56 seconds in VLC Media Player. 

 
Stop video here and ask if they can tell what happens with ‘Header and Footer’? 

Just listen to the answers and play the video again for the correct answer. 

 

 

 

 

 

 

432. To stop video time at 11 minute 28 seconds in VLC Media Player. 

 
Stop video here and ask students to insert the ‘Header and Footer’ on the writer page 

and then play the video again. 

 

433. To stop video time at 12 minute 10 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Header as shown in the video and then play 

the video again. 

Now just check whether they’ve inserted ‘Header or not and then play the video again. 
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434. To stop video time at 13 minute 43 seconds in VLC Media Player. 

Stop video here and ask students to insert date and time in the ‘Header’ box as shown 

in the video and then play the video again. 

 

435. To stop video time at 14 minute 53 seconds in VLC Media Player. 

Stop video here and ask students to insert ‘Footer’ as shown in the video and then ask 

them to insert page number in the ‘Footer’ box as shown in the video. 

Now just check whether they have inserted ‘Header or Footer’ or not and then play the 

video again. 

436. To stop video time at 14 minute 59 seconds in VLC Media Player. 

 
Stop video here and ask students to do practice of ‘Character’ option and then play the 

video again. 

 

437. To stop video time at 15 minute 05 seconds in VLC Media Player. 

Stop video here and ask if they can tell what we can do with ‘Characters’ submenu? 

Just listen to the answers and play the video again for the correct answer. 

 

438. To stop video time at 15 minute 25 seconds in VLC Media Player. 
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Stop video here and ask students to make the line ‘Bold’ and ‘Italic’ then play the 

video again. 

 

439. To stop video time at 16 minute 49 seconds in VLC Media Player. 

Stop video here and check whether they’ve made the line bold and italic or not and 

then play the video again. 

 

440. To stop video time at 16 minute 55 seconds in VLC Media Player. 

 
Stop video here and ask the students to do practice of ‘Effects’ option and then play 

the video again. 

 

441. To stop video time at 14 minute 52 seconds in VLC Media Player. 

 
Stop video here and ask students to apply over line on the second line and then play 

the video again. 

 

442. To stop video time at 18 minute 25 seconds in VLC Media Player. 

Stop video here and check whether they have applied over lining or not then play the 

video again. 

 

443. To stop video time at 18 minute 40 seconds in VLC Media Player. 
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Stop video here and ask the students to practice ‘Background’ option and then play the 

video again. 

 

444. To stop video time at 19 minute 49 seconds in VLC Media Player. 

Stop video here and check whether they’ve changed the ‘background color’ or not 

then play the video again. 

 

 

 

 

 

445. To stop video time at 19 minute 57 seconds in VLC Media Player. 

 
Stop video here and ask the students to practice ‘Page Border’ option and then play 

the video again. 

 

446. To stop video time at 21 minute 04 seconds in VLC Media Player. 

Stop video here and check whether they’ve applied the ‘Page Border’ or not then play 

the video again. 

 

447. To stop video time at 21 minute 13 seconds in VLC Media Player. 
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Stop video here and ask the students to create the ‘table’ and ask to make sales list in 

it and then play the video again. 

448. To stop video time at 21 minute 25 seconds in VLC Media Player. 

 
Stop video here and ask the students to close the writer file and then shut down the 

computer.Just check whether they have shut down the computer or not. 

 

 

 

 

 

 

 

 

 


